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LESSON  2.  INTRODUCTION TO JALIS 

Setup.  To accomplish this lesson, you will need access to a computer with connectivity to JALIS and a web 
browser. 

 

Slide 2-1.  Introduction to JALIS  

Terminal Learning Objective: 

Given an operational JALIS environment, explore the functionality of the JALIS system and the JALIS home page. 

Enabling Learning Objectives: 

1.  Given instruction, become familiar with the functionality of JALIS. 

2.  Given instruction, successfully navigate through JALIS menus and screens. 

3.  Given instruction, bookmark a request. 

4.  Given instruction, query a request in JALIS. 

5.  Given instruction, print a Flight Advisory Message. 

6.  Given instruction, e-mail a Flight Advisory Message. 

7.  Given instruction, become familiar with the contents of the JALIS home page. 
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LESSON  2.  INTRODUCTION TO JALIS 

Terminal Learning Objective: 

Given an operational JALIS environment, explore the functionality of the JALIS system and the JALIS home page. 

 

Slide 2-2.  We will cover… 

Lesson Overview.  The history of OSA scheduling and JOSAC’s CONOPS were discussed during the 
previous lesson.  During this lesson you will learn about the JALIS environment, general navigation in 
JALIS, bookmarking, and E-mail and printing capabilities.  Additionally, you will cover World Wide Web 
(WWW) applications that, although not in JALIS, can assist in the scheduling process. 

Transition.  As with any application, you need to have an understanding of how it came about and what it 
is used for.  First, you will learn the purpose and history of JALIS. 

OBJECTIVE 2 -1.  Given instruction, become familiar with the functionality of JALIS. 

I.  JALIS.  JALIS is the computer system used to accomplish OSA requesting, scheduling, and reporting. 

A.  Purpose.  The purpose of JALIS is to provide centralized on-demand air logistics requesting, 
planning, scheduling, and messaging for joint Services OSA.  It also provides historical airlift data 
and some reporting capabilities. 

B.  History.  Simply stated, JALIS is a centralized, multi-user, menu-driven information system 
using relational database management technology.  ORACLE was chosen because of its portability 
between environments enabling JALIS to run on a number of different platforms.  The JALIS 
application uses Metaframe system software for thin-client/server computing.  JALIS is installed on 
a multi-processor UNIX operating system.  It has been established as the DoD standard for on-
demand logistics airlift scheduling and consolidation of historical airlift data.  As you remember, 
JALIS replaced NALIS and is used to schedule OSA assets for the military Services at the direction 
of USTRANSCOM.   

Transition.  Now that you have reviewed the purpose and history of JALIS, you need to set the stage for 
the actual system itself. 
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C.  Terminal Hardware and Software Components.  JALIS operates at three CONUS locations 
(NALO, New Orleans, LA; USTRANSCOM, Scott AFB, IL; OSAA, Fort Belvoir, VA) and three 
Navy OCONUS sites (Bahrain, Japan, and Italy). 

1.  Hardware.  There are currently two methods used to establish a terminal connection to 
JALIS. 

a.  Modem Session.  When you establish a modem session from a personal computer 
(PC) to another remote computer, you are making a telephone call from one system to 
another. 

b.  Telecommunications Network (TELNET) Session.  TELNET is the Internet 
standard protocol for remote terminal connection services.  It is also a term used to 
describe the act of accessing a remote computer system through a combination of one 
or more local area, wide area, or metropolitan area networks.  When you TELNET 
from a local terminal to any other remote computer, you are establishing a logical 
connection through a combination of network cables, satellite transmissions, and, in 
some cases, telephone cabling. 

c.  Web.  At some point in the future, many users will be able to access JALIS through 
a web browser. 

2.  Software.  The software required to access JALIS is Citrix WinFrame, which may be 
installed on your workstation by downloading it via the Internet or your intranet.  This thin 
client application software executes 100% on the JALIS server and only updates the screen.  
Because mouse movements and keystrokes are transmitted over the network while all logic 
functions are executed on the server, users enjoy high performance, regardless of available 
bandwidth.  Users working remotely can dial into the JALIS server and obtain local area 
network (LAN)-like application performance.  The WinFrame software was chosen because 
of its capability to centrally deploy applications across heterogeneous computing 
environments to users of a wide range of hardware, operating platforms, and network 
connections. 

Note.  You will need to operate a Disk Operating System (DOS) or Windows system to use WinFrame. 

D.  Procedures for Requesting Permissions.  As with all major computer systems there are certain 
procedures that must be followed to obtain permission to access the system. 

1.  Request for Permissions .  You may enter your account application over the internet from 
the JALIS web page.  The agency that provided the training will certify that you have been 
trained.  The Programs, Analysis, and Systems Management (PASM) shop at JOSAC will set 
up your userid and pass the approval along to the JALIS Systems Administrators who will 
actually create your account.  The system will send you an email stating that your account has 
been created and tell you what to do to activate it.  The whole process is done electronically.  
Navy users will have to complete a NALO form 5280.1E, User Access Request, discussed 
later in this lesson and fax it to NALO to get your account set up in the Navy system.  

Note.  The Terminal Area Security Officer (TASO) is a JALIS specific term for the security person associated with 
JALIS. 

2.  Types of Permissions.  The four most commonly assigned permissions are System 
Administration, Scheduler, Requester, and Squadron User. 

a.  System Administration (SA).  The system administrators are responsible for the 
technical side of JALIS.  These people build, back up, and maintain the database; and 
grant end-user permissions.  They are also responsible for assisting the users with 
database and other technical problems. 
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b.  Scheduler.  The schedulers have the capability to create, review, and modify any 
data associated with airlift schedules. 

c.  Requester.   The requesters have permissions for maintaining passenger files; 
creating, maintaining, and reviewing airlift requests; displaying flight advisories; 
displaying mission itineraries; and entering proposed plans for flight routes. 

d.  Squadron User.  The squadron user permissions are associated with data about 
actual aircraft and the missions they perform.  These will be “in the field” permissions 
to ensure the aircraft, aircrew, and flight hour information is accurate and post mission 
reporting is accomplished. 

3.  User Identification (ID) and Password.  Authorized users are required to have a User ID 
and password.  User IDs are issued by the SA/Functional Manager.  Users create their own 
passwords within the following guidelines: 

• All passwords will expire every 90 days and they cannot be re-used for 7 password 
changes. 

• Passwords must be at least 8 characters long 

• They must contain at least one upper case letter  (ex.  J) 

• They must contain at least one lower case letter  (ex.   j) 

• They must contain at least one numeral character (ex.  1) 

• They must contain at least one special character (ex. @) 

• They cannot contain your user name or any part of your full name  (ex. JOE) 

4.  User IDs and passwords are assigned to individuals and ARE NOT TO BE SHARED 
with other JALIS users.  Each user must have and use his or her own account.  Sharing of 
accounts is grounds for termination of the account. 

Transition.  Now that user permissions and procedures to obtain a User ID and password have been 
covered, you will be introduced to the procedures used to logon to JALIS. 

E.  Accessing JALIS by Dial-up Modem.  Your SA should be consulted and should be a great help 
in setting up your system properly.  You will first have to dial in to the JALIS servers.  Then you can 
logon to JALIS using the ICA icon.  Check with your SA for exact procedures at your location if 
you are not sure how to configure your software properly.  If you are accessing JALIS from a 
broadband modem (cable or Digital Subscriber Line (DSL)), there is no special configuration 
required.  It works just like the TELNET connection discussed below. 

F.  Accessing JALIS by TELNET.  Accessing JALIS can be accomplished with a PC connected to 
a LAN. 

1.  Establishing a TELNET Session.  Start a WinFrame software session by double clicking 
on the appropriate icon on your desktop and logon to JALIS.  The ICA file is designed to 
balance the load among the JOSAC servers.  Procedures for accessing the NALO and OSAA 
servers may differ somewhat. 

2.  Terminating a TELNET Session.  Properly exiting JALIS will automatically close the 
WinFrame window and terminate your TELNET connection. 
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G.  Logging onto JALIS.  As mentioned before, there are two ways to logon to JALIS:  TELNET or 
modem.  Once the computer is on, the Windows Desktop will appear (similar to that shown in 
Figure 2-1), depending on your operating system. 

 

Figure 2-1.  Windows Desktop 

Note.  The comment column of the keystroke tables throughout this training manual will sometimes offer alternate 
methods to perform the same function. 

Note.  The newtrng.ica icon referred to throughout this Training Manual is the icon used in the classroom.  The icon 
to be used outside the classroom is newjalis .ica. 

 

LOGON 

Step Activity Anticipated Result Comment 

1 of 4 

Double Click  on the 
newtrng.ica icon. 

JOSAC JALIS Message screen 
(Fig. 2-2) displays. 

READ THE MESSAGE!  It will 
change from time to time and should 
be read as it frequently contains 
important information regarding 
policy or system changes. 
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Figure 2-2.  JOSAC JALIS Message Screen 

 

LOGON 

Step Activity Anticipated Result Comment 

2 of 4 Click  on the OK button. Logon Information screen (Fig. 
2-3) displays. 
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Figure 2-3.  Logon Information Screen 

 

LOGON 

Step Activity Anticipated Result Comment 

3 of 4 

Type {your assigned 
username}.  Press <Tab> . 

The information you typed 
displays in the Username: field.  
Cursor moves to the Password 
field. 

Username and Password will be 
provided by the instructor. 

4 of 4 

Type {your assigned 
password} .  Press 
<Enter>. 

Asterisks display in the 
Password: field.  Joint Air 
Logistics Information System 
Welcome screen (Fig. 2-4) 
displays. 

You may also Click on the OK 
button. 

Note.  If your logon does not work after three tries, your account will be locked, so enter the information carefully.  
The password is case-sensitive; the username is not.  To get your account unlocked you will have to call the 
USTRANSCOM Help Desk. 
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Figure 2-4.  Joint Air Logistics Information System Welcome Screen 

Objective Summary.  You should know by now the JALIS was originally developed by the Navy, you 
must have a userid and password to access the system, and that it is used to request, schedule, and report 
OSA airlift. 

Transition.  Now that you are logged into JALIS, you need to know how to navigate through the system. 

OBJECTIVE 2 -2.  Given instruction, successfully navigate through JALIS menus and screens. 

II.  JALIS Environment.  JALIS functions in a windows-based environment and operates from a menu 
and sub-menu system.  Like other Windows applications, you can operate using menu options (with pull-
down and cascading menus), icons from the toolbar, or keystrokes. 

Note.  Although JALIS looks like most other Windows programs, it does not always function as you might expect it 
to function.  JALIS is an older program that has been adapted to the Windows environment. 

A.  Key Conventions.  Throughout the course you will find keystroke tables that contain specific 
activities for you to follow.  Items contained within < > indicate specific keys that are to be used.  
For example, <↓> means the down arrow key.  Items contained within the { } brackets designate 
specific items that must be typed in the specific field.  For example, {your password} would indicate 
you should type your exclusive password.  Items contained within “ ” designate specific items that 
must be typed just as presented in the specific field.  Items in bold with the word tab, button (or 
navigation button) following indicate you need to click on the appropriate tab or button.  Items in 
bold with the word icon following indicate you need to click on the appropriate icon.  For example, 
click on the SAVE icon means you would click on the icon that looks like the computer disc.  Items 
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in bold with the words menu option following indicate you need to click on the appropriate word on 
the menu bar.  For example, click on the JALIS menu option means you would click on the word 
JALIS on the menu bar. 

Note.  You can also use alternate keystrokes to activate menus and submenus, e.g., <Alt + J> would activate the 
JALIS menu and <S> would activate the Flight Scheduling and Modifications submenu. 

B.  Menu Bar.  JALIS is a menu-driven system.  The Menu Bar is the rectangular area at the top of 
the screen that contains the titles of eight pull-down menu options with various applications.  They 
include the JALIS, File, Edit, Record, Query, Recent Modules, Window, and Help menus.  Only five 
of these are available on the Welcome Screen.  Selecting an option on the JALIS menu leads you to 
submenus.  These submenus allow you to access specific options. 

1.  Main Menu Bar Navigation.  Menu options are selected by clicking on the appropriate 
selection.  Pull-down menu options will further define your selections. 

 

MENU BAR 

Step Activity Anticipated Result Comment 

1 of 10 Click  on the JALIS  menu 
option. 

JALIS pull-down menu (Fig. 2-5 
through Fig. 2-7) displays. 

You may also Press < Alt + J >. 

Note.  The pull-down menu you receive depends on your permissions and your role in JALIS 
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Figure 2-5.  Requester Pull-down Menu 
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Figure 2-6.  Squadron User Pull-down Menu 
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Figure 2-7.  Scheduler Pull-down Menu 

2.  JALIS Pull-down Menu.  The type of permissions you have (requester/validator, 
squadron user, or scheduler) determines which JALIS pull-down menu you encounter.  The 
appropriate menu options for your role are depicted in Figures 2-5 through 2-7 and vary 
depending on whether you are a requester/validator, squadron user, or scheduler. 

a.  Flight Scheduling and Modifications Menu.  Submenus contain the modules 
required for building missions.  This menu option is part of the scheduler permissions 
(Figure 2-7). 

b.  Airlift Request Menu.   Submenus contain the modules required for building 
requests.  This menu option is part of the requester/validator permissions (Figure 2-5) 
and scheduler permissions (Figure 2-7). 

c.  Messaging Menu.  Submenus contain the modules required for generating and 
releasing mission messages.  This menu option is part of the requester/validator 
permissions (Figure 2-5) and scheduler permissions (Figure 2-7). 

d.  Aircraft Files Menu.  Submenus contain the modules required for checking and 
changing the availability of aircraft, unit of assignment, available configurations, etc.  
This menu option is part of the scheduler permissions (Figure 2-7). 

e.  Remote Requester User Menu.  Submenus contain the modules required for 
generating requests, which include entering and maintaining passenger data, entering 
and modifying requests, displaying flight advisories, and tracking the status of 
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requests.  This option is for remote requesters without validation or verification 
authority (Figure 2-5) and squadron users (Figure 2-6). 

f.  Remote Squadron User Menu.  Submenus contain the modules required for units 
flying missions in support of JOSAC tasking to display flight advisories for missions, 
input aircraft status, maintain Logistic Flight Records, and create Aviation Exception 
Reports.  This option is for squadron users (Figure 2-6). 

g.  Squadron Administration Menu, Data Administrator Maintenance Menu, 
Data Administrator Reports Menu, Systems Department Menu, System 
Administration Menu, and the four Programmer’s Menus.  These menus are 
reserved for Systems Administration personnel, program developers, and database 
maintenance personnel. 

h.  Plans and Analysis Reports Menu.  Submenus contain required modules for the 
PASM team of JOSAC.  The permission for this menu option is restricted to the 
PASM team of JOSAC. 

Note.  Grayed out menu options are not available. 

 

MENU BAR 

Step Activity Anticipated Result Comment 

2 of 10 

Click  on the Airlift 
Request Menu option. 

Squadron Users Click  on 
the Remote Re quester 
User Menu option. 

Airlift Request cascading menu 
(Fig. 2-8) displays. 

Remote Requester User 
cascading menu displays. 

You may also Press <R>. 

 

You may also Press <Q>. 
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Figure 2-8.  Airlift Request Cascading Menu 

 

MENU BAR 

Step Activity Anticipated Result Comment 

3 of 10 Click  on Input Airlift 
Request. 

Input Airlift Request screen (Fig. 
2-9) displays. 

You may also Press <I>. 
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Slide 2-3.  Input Airlift Request Screen 

 

Figure 2-9.  Input Airlift Request Screen 

Note.  You should notice that JALIS has automatically expanded the window when this large screen opens.  If you 
are working on some of the smaller screens, you may wish to expand the window by clicking on the Restore symbol 
at the top right corner of the middle window. 
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MENU BAR 

Step Activity Anticipated Result Comment 

4 of 10 Click  on the File menu 
option. 

File pull-down menu (Fig. 2-10) 
displays. 

You may also Press <Alt + F>. 

 

 

Figure 2-10.  File Pull-down Menu 

3.  File Pull-down Menu.  The File pull-down menu has three options:  Save/Commit, Print 
Screen, and Exit JALIS. 

a.  Save/Commit.  This option saves your data.  This function is not automatic in all 
modules.  You should save (commit) your work at the end of every block or screen. 

b.  Print Screen.  This option allows you to print the current screen (see Appendix M). 

c.  Exit JALIS.  Selecting this option will exit you from the current module or screen.  
If you are on the JALIS Welcome screen, you will exit JALIS.  It will also cancel the 
Query mode if you are in the Query mode. 
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MENU BAR 

Step Activity Anticipated Result Comment 

5 of 10 Click  on the Edit menu 
option. 

Edit pull-down menu (Fig. 2-11) 
displays. 

You may also Press <Alt + E>. 

 

 

Figure 2-11.  Edit Pull-down Menu 

4.  Edit Pull-down Menu.  The Edit pull-down menu has five options:  Cut, Copy, Paste, 
Clear All, and Edit. 

a.  Cut, Copy, Paste.  These are typical windows functions and are displayed in black 
when they are available. 

b.  Clear All.  This option clears all the records out of a collection.  The database is not 
affected. 

c.  Edit.  This option launches the Notepad text editor program if selected from a free-
type field. 

Note.  Certain fields within JALIS allow you to enter free-type text describing a condition or noting important 
information.  When typing this information, you may like a larger workspace so you can see all that you have typed, 
rather than only the portion visible in the field.  You can access Notepad by either clicking on the Edit icon (the 
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writing pencil icon) on the toolbar or by clicking on the Edit pull-down menu and choosing Edit.  When you select 
Edit, Notepad will pop up.  Type in your text.  Select File from the Notepad menu bar (NOT the JALIS menu bar).  
Select Save from the drop-down menu (NOT the Save icon on the JALIS toolbar), which will save the text you have 
just entered.  Select File from the Notepad toolbar again.  Select Exit.  You will return to the screen you were on and 
the data you typed in will appear in the field.  Using Notepad with JALIS requires caution.  The important thing to 
remember is to work ONLY within the Notepad window when you have Notepad open.  Clicking anywhere outside 
the window will lock up your session.  Since the latest update to JALIS changed all the remarks fields to text  editors, 
there is really not much need to use the Edit function. 

 

MENU BAR 

Step Activity Anticipated Result Comment 

6 of 10 Click  on the Record menu 
option. 

Record pull-down menu (Fig. 2-
12) displays. 

You may also Press <Alt + R>. 

 

 

Figure 2-12.  Record Pull-down Menu 

5.  Record Pull-down Menu.  The Record pull-down menu has six options:  Previous, Next, 
Clear, Delete, Insert, and Duplicate.  These options refer directly to functions you can do to a 
record or group of data in JALIS. 
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a.  Previous and Next.  These two options allow you to navigate among records in a 
collection or on a screen.  The up and down arrow keys on the keyboard accomplish 
the same functions as these two options. 

b.  Clear.  This option will remove a record from a collection of records.  It will also 
clear data out of a record.  It does not affect the database. 

c.  Delete.  This option will delete a record from the JALIS database.  You must save 
the record to make the deletion effective. 

d.  Insert.  This option will insert a blank record at a point after the current location of 
the cursor.  Selecting this option from certain fields on the Input Airlift Request screen 
will provide you the opportunity to duplicate the currently viewed request. 

e.  Duplicate.  This option will permit you to duplicate the current request.  You must 
change at least one of the first three data elements (DTG, Lift, or UIC) and those 
remaining data elements that need to be changed because of the new request. 

 

MENU BAR 

Step Activity Anticipated Result Comme nt 

7 of 10 Click  on the Query menu 
option. 

Query pull-down menu (Fig. 2-
13) displays. 

You may also Press <Alt + Q>. 
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Figure 2-13.  Query Pull-down Menu 

6.  Query Pull-down Menu.  The Query pull-down menu has five options: Enter, Execute, 
Last Criteria, Cancel, and Count Hits.  These options refer directly to the different query 
functions available to you. 

a.  Enter.  This option changes JALIS from the input mode to the query mode. 

b.  Execute.  This option executes the query if you are in the query mode. 

c.  Last Criteria.  This option reposts the criteria from the last query.  JALIS will not 
hold the criteria indefinitely. 

d.  Cancel.  This option cancels the query mode and enters the input mode. 

e.  Count Hits.  This option indicates, on the Message Line, how many records will be 
retrieved before you execute the query. 

 

MENU BAR 

Step Activity Anticipated Result Comment 

8 of 10 Click  on the Recent 
Modules  menu option. 

Recent Modules pull-down 
menu (Fig. 2-14) displays. 

You may also Press <Alt + M>. 
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Figure 2-14.  Recent Modules Pull-down Menu 

7.  Recent Modules Pull-down Menu.  The Recent Modules pull-down menu has no set 
options but will display up to the last five modules you have visited during the current JALIS 
session.  You can click on one of these modules to move back to the selected module. 

 

MENU BAR 

Step Activity Anticipated Result Comment 

9 of 10 Click  on the Window menu 
option. 

Window pull-down menu (Fig. 
2-15) displays. 

You may also Press <Alt + W>. 
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Figure 2-15.  Window Pull-down Menu 

8.  Window Pull-down Menu.  The Window pull-down menu has four options: Cascade, 
Tile, Arrange Icons, and a Module History summary.  These are mainly Windows 
applications and do not have a function in JALIS. 

Note.  The Module History Summary only displays the current window.  You can now use the Recent Modules 
menu to navigate between windows. 
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MENU BAR 

Step Activity Anticipated Result Comment 

10 of 10 Click  on the Help menu 
option. 

Help pull-down menu (Fig. 2-
16) displays. 

You may also Press <Alt + H>. 

 

 

Figure 2-16.  Help Pull-down Menu 

9.  Help Pull-down Menu.  The Help pull-down menu has six options:  Help, Show Keys, 
List, Display Error, Change JALIS Password, and About JALIS. 

a.  Help.  This option displays a context -sensitive help screen providing explanations 
of what goes in the fields. 

b.  Show Keys.  This option displays a pop-up listing all available keystroke 
combinations usable in JALIS. 

c.  List.  This option displays a selection box where the user can find an item in the 
database. 

d.  Display Error.  This option will sometimes display an error message when JALIS 
is encountering problems. 
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e.  Change JALIS Passw(or)d.  This option is only available to users on the NALO 
and OSAA servers and allows them to change their Oracle passwords. 

f.  About JALIS.  This option displays an information pop-up stating that JOSAC 
JALIS will go down every Friday at 16:30 CST for system maintenance. 

 

NAVIGATE TO INPUT AIRLIFT REQUEST SCREEN 

Step Activity Anticipated Result Comment 

1 of 1 
Click  on a blank space 
anywhere on the screen to 
close the Help menu. 

Input Airlift Request screen (Fig. 
2-17) redisplays. 

 

 

 

Figure 2-17.  Input Airlift Request Screen 

C.  Input Airlift Request Screen.  Figure 2-17 is an example of an input screen, which is divided 
into eight sections configured with the following: 

1.  Screen Header.   The screen header is at the top of the inner window.  It contains the name 
of the system, your userid, the database you are logged into, and the title of the screen you are 
currently viewing. 

2.  Menu Bar.  The Menu Bar contains the pull-down menus available for use.  These menus 
are:  JALIS, File, Edit, Record, Query, Recent Modules, Window, and Help.  You can access 
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these menus by clicking on them with your mouse or by pressing <Alt> in conjunction with 
the underlined letter. 

3.  Toolbar.   The toolbar contains 15 icons representing the options available to you. 

Note.  Pausing your cursor over an icon will cause a pop-up to appear to the right of the icon that identifies the 
function of the icon. 

a.  Computer Disk.  Save/Commit.  This icon saves your record and commits it to the 
database.  (You may also Press <F10>.) 

b.  Computer Printer.  Print Screen.  This icon prints the displayed screen.  (You may 
also Press <Shift + F8>.) 

Note.  See Appendix M for printer set-up procedures. 

c.  Flashlight.  Query.  This icon searches the system for requested records.  If you are 
in the Query mode, it will execute the Query.  If you are in the Input mode, it will enter 
the Query mode.  (You may also Press <F7> to enter the Query mode or <F8> to 
execute the Query.) 

d.  Green Plus  Sign.  Insert.  This icon lets you insert a blank record.  It will be added 
after your current record.  You must save your work before the new record is actually 
added to the database.  Selecting this option from certain fields on the Input Airlift 
Request screen will provide you the opportunity to duplicate the currently viewed 
request.  (You may also Press <F6>.) 

e.  Red X.  Delete Record.  This icon lets you delete a record from the database.  This 
selection eliminates the record from the screen, but you must also save the change to 
the database to complete the process.  (You may also Press <Shift + F6>.)  Remember, 
there is no undo capability in JALIS. 

f.  Drop Down Arrow.  List.  This icon opens a list of values available for certain 
fields.  (You may also Press <F9>.) 

g.  Writing Pencil.  Edit.  This icon opens Notepad, giving you more space for writing 
remarks and other information.  (You may also Press <Ctrl + E>.) 

h.  Right Green Arrow.  Next Block.  This icon moves you to the next block in a 
module.  (You may also Press <Ctrl + Pg Down>.) 

i.  Left Green Arrow.  Prev(ious) Block.  This icon moves you to the previous block 
in a module.  (You may also Press <Ctrl + Pg Up>.) 

j.  Up Arrow.  Prev(ious) Record.  This icon moves you to the previous record 
available.  (You may also Press <↑>.) 

k.  Down Arrow.  Next Record.  This icon moves you to the next record available.  
(You may also Press <↓>.) 

l.  Pencil Eraser Over a White Field.  Clear Record.  This icon clears the record on 
which you are working and takes you to the next record.  This does not delete any 
information from the database. 

m.  Pencil Eraser Over an Entire Screen.  Clear Form.  This icon clears an entire 
screen.  (You may also Press <Shift + F7>.)  This command does not delete any data 
from the database. 
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n.  Question Mark.  Help.  This icon opens on-line help text.  (You may also Press 
<F1>.) 

o.  Red Door.  Exit.  This icon performs three different functions.  If you are in the 
Query mode, it will cancel the Query mode, leaving you in the Input mode.  If you are 
in the Input mode, it will close the screen you are on and take you back to the previous 
screen, including the JALIS Welcome screen.  If you are on the JALIS Welcome 
screen, it will exit JALIS.  (You may also Press <Ctrl + q> for all of these options.) 

4.  Tabs or Navigation Buttons.  Some JALIS screens have navigation buttons.  These 
buttons allow access to related screens and data blocks.  These buttons will appear as separate 
buttons below the Toolbar.  They are not available on all JALIS screens.  Some of the newer 
screens, such as the Input Airlift Request screen, have tabs that perform the same function as 
the navigation buttons on some screens.  On the new Input Airlift Request screen, the tabs are 
located below the solid horizontal line that divides the screen and are used to change the 
display on the lower half of the screen. 

5.  Navigate Window.  The Navigate window (usually on the right side of the toolbar, when 
available) provides a pull-down list of options for direct navigation to different modules.  The 
selections vary depending on the screen in which you are currently working. 

6.  Data Block.  A data block contains the fields or entry spaces in which you enter, view, or 
maintain data.  Each block represents a logical grouping of related data and is separated into 
distinct sections identified by a distinct border. 

7.  Message Line.  The Message Line (normally dark blue) is located at the bottom of each 
JALIS screen, just above the aqua Status Line.  This line contains specific instructions about 
navigation, data content, errors, and general use.  All messages are displayed in the Message 
Line at the bottom of the screen.  Error messages may also display in a pop-up screen that 
displays when the error is made. 

a.  Navigation/Help Instruction Messages.  Navigation/Help messages help you 
navigate through screens/blocks, execute system commands, and enter data into 
specific fields. 

b.  Data Entry/Field Validation Messages.  Validation messages display when you 
enter an invalid value into a specific field.  JALIS also displays a validation error if 
you try to bypass a required field. 

c.  System Error Messages.  System error messages indicate there are problems with 
JALIS forms, JALIS database tables, or ORACLE.  These problems may be software 
errors, hardware problems, or system operator errors. 

Note.  The Message Line is the most direct point of communication between you and JALIS.  Always monitor the 
Message Line for guidance about how to use JALIS effectively. 

8.  Status Line.  The Status Line is located at the very bottom of the screen and provides 
several standard pieces of information.  It is normally aqua in color and is divided into 
sections. 

a.  Record Count.  JALIS counts the number of records through which you have 
scrolled or entered and indicates the number after the word “Record” in the first 
section of the Status Line.  The question mark after the slash indicates that you have 
not yet reached the last record in the collection.  When you navigate to the last record, 
the ques tion mark will change to a number indicating the total number of records in the 
collection.  If you navigate back up the collection of records, the first number will 
change, indicating the number of the record being displayed. 
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b.  Query/Input Mode.  If you enter a module in the Query mode or the system has 
been alerted you want to enter a query, Enter-Query displays in the second section of 
the Status Line.  If you are in the Input mode, nothing will display in the second 
section of the Status Line.  You must be in the Input mode to create new records and 
save (commit) new data. 

c.  List.  If List of Values (LOV) displays in the third section of the Status Line, a list 
of values is available for the field.  Some fields with LOVs available have a List icon 
to their right.  In such cases, you can click the List icon and the LOV will display.  In 
all cases, you may Press the <F9> key to display the list of values, or click the List 
icon on the toolbar. 

Note.  Display-only fields are gray in color, depending on the software being run on the server you are logged onto.  
These fields contain system-generated information that is for information only.  You cannot enter information in a 
display-only field, nor can you modify any information in a display-only field.  In the Input mode, fields that appear 
in white are mandatory fill-in items.  In the Input mode, fields that appear in blue are optional fill-in items.  These 
optional items will appear gray, the same color as the display-only fields in some systems, depending on the 
software running on the server.  JALIS will allow you to enter some of these fields in the Query mode.  If so, you 
can execute a query based on that information, e.g., Status or International Civil Aviation Organization (ICAO) 
fields. 

 

Slide 2-4.  Input Airlift Request Screens 

D.  Small Input Airlift Request Screen.  Some users, primarily Army and Navy users, will not 
have access to the new large Input Airlift Request screen (Figure 2-17) that we have been discussing.  
They will still have the older small version of the Input Airlift Request screen as shown in Figure 2-
18 below. 
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Figure 2-18.  Small Input Airlift Request Screen 

1.  Major Difference.  Besides the size of the screen and the arrangement of the fields, there 
is really only one major difference between the two screens.  The larger screen always 
displays the information from the Request screen on the upper part of the screen with the 
information from the additional screens displayed in the lower portion one screen at a time.  
These screens are selected by clicking on the Tabs above the lower portion.  In the small 
screen, the Request information is not always visible.  It is just one of several screens.  The 
different screens are selected by clicking on the Navigation buttons at the top of the screen, 
just below the Toolbar.  The functionality of the screens is basically the same. 

2.  Minor Differences.  The small screen does not have the Lock for update checkbox that 
must be checked before you can modify the request.  The functions of the two Tabs that do 
not match Navigation buttons are accessible from the Navigate window. 

Note.  Please stay with the instructor during the navigation portion of this lesson.  We are demonstrating specific 
functionalities within JALIS in this lesson.  We are not necessarily going in any logical sequence. 

Transition.  You have reviewed the basics of the JALIS windows and screens and have seen what the 
menu options and icons allow you to do.  It is now time to put this knowledge into practice with some 
general navigation. 

E.  Mode.  JALIS operates in two modes; the Query mode where you can retrieve data from the 
database, and the Input mode where you can enter information into the database.  Not all screens in 
JALIS display initially in the same mode, therefore, it is imperative that you get your bearings first 
so you know what you need to do.  If the screen displays “Enter-Query” in the second section of the 
Status Line, you are in the Query mode.  If the second section of the Status Line is empty, you are in 
the Input mode. 
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1.  Enter Query.  To enter the Query mode from the Input mode, you can Press <F7>, select 
Enter from the Query menu option, or click on the Query icon.  This command puts you in the 
Query mode to locate data.  It will clear any data currently displayed. 

2.  Execute Query.  To execute the query once you are in the Query mode, you can Press 
<F8>, select Execute from the Query menu option, or click on the Query icon.  This 
command begins the search for the criteria you are after.  It retrieves all of the records from 
the database that are referenced by the data you provide. 

3.  Exit/Cancel the Query.  To exit the Query mode and get to the Input mode, you can Press 
<Ctrl + q>, select Exit from the File menu option, or click on the Exit icon.  This command 
terminates a query process. 

Note.  If the Message Line on the Input Airlift Request Module reads, “Enter a query; Press <F8> to execute, <^q> 
to cancel.”, pressing <Ctrl + q> puts you in the Input mode. 

 

PRACTICE NAVIGATION - QUERY FOR DTG 

Step Activity Anticipated Result Comment 

1 of 2 In the DTG(Z) field, Type 
“020800012007” . 

020800012007 displays in the 
DTG(Z) field. 

You may also select Execute from 
the Query menu option. 

2 of 2 

Click  on the Query icon. Input Airlift Request screen (Fig. 
2-19). 

Retrieves all records matching that 
DTG.  On the large Input Airlift 
Request screen, you must lock the 
retrieved request before you can 
make any modifications to it. 
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Figure 2-19.  Input Airlift Request Screen with Query Results  

Note.  The standard format for a DTG in JALIS is DD HHmm MM YYYY (with or without the spaces between 
groups); other formats will be covered as they come up in the course. 

F.  Practice Navigation. 

1.  Arrow Keys.  Move the cursor within a group of records.  The <↓> and <↑> keys move 
you within the group of records that match your query.  The <→> and <←> keys move 
forward and backward within a field, provided there is data entered. 
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PRACTICE NAVIGATION - INPUT AIRLIFT REQUEST SCREEN 

Step Activity Anticipated Result Comment 

1 of 6 Press <↓>. Next request is displayed. You may also Click on the Next 
Record icon. 

2 of 6 

Repeat step 1 until you 
scroll to the last record. 

Results move down one record 
at a time.  The counter increases 
as you move down the list and 
the ? on the Status Line 
disappears when you get to the 
last record and is replaced with 
the total number of records in 
the collection. 

If you press the <↓> one more time 
you get a pop-up asking, “Do you 
wish to add another lift to this 
request?”  Yes will put you in the 
duplicate mode to duplicate the 
current request.  No will put you on 
a blank record in the Input mode.  
Cancel will close the pop-up, 
leaving you on the current record.   

3 of 6 
Press <↑> to navigate to 
previous records. 

Results move up one record at a 
time. 

You may also Click on the Previous 
Record icon.  As the records change, 
the counter changes. 

 

Note.  Notice that when you enter the Input Airlift Request screen you are nearly always in the Query mode.  You 
will know this by looking at the Status Line to see if Enter-Query is displayed.  If you come back to this screen 
during the same JALIS session, the previous record may be displayed in the Input mode. 

Transition.  Now you know the arrow keys enable you to scroll through records.  Next, you will navigate 
through the Input Airlift Request screen. 

2.  Screen Navigation Techniques.  Navigation through a JALIS screen can be done with 
specific menu options, toolbar selections, and with specific keystrokes.  The following 
methods are most often used in JALIS. 

a.  Next Field.  To navigate to the next field, you can Press <Tab>.  This command 
allows you to move between fields of data within a particular block on the screen.  You 
may also click on the next field.  Do not use the <Enter> key to move between fields.  
It will move the cursor but it is designed to select items from a pick list in JALIS.  
Using the <Enter> key to move between fields sometimes creates links in the database 
that will lock up your JALIS session. 

b.  Previous Field.  To navigate to previous fields, you can Press <Shift + Tab>.  This 
command allows you to move backward to the previous data field within a block.  You 
may also click on the appropriate field. 
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PRACTICE NAVIGATION - INPUT AIRLIFT REQUEST SCREEN 

Step Activity Anticipated Result Comment 

4 of 6 Press  <Tab>. Cursor moves to the Lift code 
field. 

You may also Click in the Lift code 
field. 

5 of 6 Press  <Shift + Tab>. Cursor moves back to the 
DTG(Z) field. 

You may also Click in the DTG(Z) 
field. 

6 of 6 

Press <Tab> several times, 
noticing where the cursor 
goes. 

Notice that the cursor does not 
go into every field, only into 
those fields in which you can 
enter information. 

 

 

c.  Exit/Cancel.  To exit the screen or cancel the Query mode, you can Press <Ctrl + 
q>, select Exit from the File menu option, or click on the Exit icon.  Exit has three 
functions: 

(1)  It cancels the Query mode. 

(2)  It exits you from a module you reached by use of a menu, the Navigate 
window, or a special button, and moves you back to the previous screen.  

(3)  It exits from the JALIS Welcome screen to the Desktop. 

d.  Save/Commit.  This command saves your data and commits it to the database.  
You can Press <F10>, select Save/Commit from the File menu option, or click on the 
Save/Commit icon. 

Note.  In many modules in JALIS, but not all of them, this function is automatic.  Therefore, you should save your 
work at the end of every block or screen.  When in doubt, save it.  It will not hurt anything.  JALIS will simply 
display “No changes to save” on the Message Line. 

e.  List.  The List command activates a list of acceptable values from the database for 
input into the current field.  To activate the List of Values, you can Press <F9>, select 
List from the Help menu option, or click on the List icon.  If a list is available (not all 
fields have this option), List of Values will be shown in the third section of  the Status 
Line. 

f.  Previous Block.  To move backward to the previous block, you can Press <Ctrl + 
PgUp>, click on the Previous Block icon, or click on the applicable tab or navigation 
button. 

g.  Next Block.  To move forward to the next block, you can Press <Ctrl + PgDn>, 
click on the Next  Block icon, or click on the applicable tab or navigation button. 

h.  Clear Field.   To clear a data field, you can Press <Ctrl + U>, or you may also 
highlight the field, and Press the <Delete> key.  This command clears the contents of 
the current field, but does not delete the information from the database.  This function 
only erases data from your screen. 

i.  Clear Record.  To clear an entire record’s data fields, you can Press <Alt + R> 
<C>, select Clear from the Record menu option, or click on the Clear Record icon.  
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This clears the entire record, but does not delete the record from the database.  This 
function only erases data from your screen. 

Note.  Use this option sparingly.  If you have executed a query, have several records returned, and use this option, 
the record cleared will disappear entirely from the available query results. 

j.  Help.  To activate the Help function, you can Press <F1>, select Help from the Help 
menu option, or click on the Question Mark icon.  This selection will provide you with 
on-line assistance concerning the screen on which you are currently working. 

k.  Cancel.  This selection will cancel you from the list function.  You can also Press 
<Esc>. 

G.  Using the List Function.  To activate the List of Values, you can Press <F9>, select List from 
the Help menu option, or click on the List icon.  By selecting a List function, you can display a list 
of acceptable values for input into the current field. 

Note.  In this field, you will be entering the code that identifies the airfield from which you wish to depart. 

 

PRACTICE NAVIGATION - ACTIVATE LIST SCREEN 

Step Activity Anticipated Result Comment 

1 of 2 

Click  in the Lock for 
update  checkbox. 

Input Airlift Request screen (Fig. 
2-20) displays with fields now 
editable and shows who has the 
request locked. 

You may get a series of pop-ups 
with notes about the request. 

Note.  This function is not available on the small Input Airlift Request screen. 
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Figure 2-20.  Input Airlift Request Screen with Locked Request 

 

PRACTICE NAVIGATION - ACTIVATE LIST SCREEN 

Step Activity Anticipated Result Comment 

2 of 2 
Click on the List icon 
adjacent to the Departure 
ICAO field. 

Valid ICAO Codes screen (Fig. 
2-21) displays with the first 
record highlighted. 

You may also Press <F9>. 
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Figure 2-21.  Valid ICAO Codes Screen 

H.  Find Option.  The Find option allows you to query the database on a portion or all of a List of 
Values screen.  Wildcards can be used in the place of unknown characters.  JALIS recognizes the 
percent sign (%) as a wildcard to indicate a string of characters and an underscore (_) to indicate an 
individual character.  Within the list screen, you can also use <↑> and <↓> to locate your selection 
(but this can be slow, especially if there are many items in the database).  Clicking the Find button 
will start the search.  Once JALIS has found the information you are looking for and it is 
highlighted, click on the OK button or Press <Enter> or <F10> to post your selection to the 
appropriate field. 

Requirement.  Find the ICAO for Grand Forks AFB, ND. 

 

PRACTICE NAVIGATION - FIND OPTION IN THE VALID VALUES FOR ICAO SCREEN 

Step Activity Anticipated Result Comment 

1 of 5 Click  in the Find field to 
the right of the %. 

Cursor displays in the Find field. You may also Press <Tab> (4 
times). 
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PRACTICE NAVIGATION - FIND OPTION IN THE VALID VALUES FOR ICAO SCREEN 

Step Activity Anticipated Result Comment 

2 of 5 In the Find field, Type 
“forks”. 

%forks displays in the Find 
field. 

 

3 of 5 

Click  on the Find button. Valid ICAO Codes screen (Fig. 
2-22) displays with the 
airfield(s) associated with your 
find parameters. 

 

 

 

Figure 2-22.  Valid ICAO Codes Screen with Query Results 
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PRACTICE NAVIGATION - FIND OPTION IN THE VALID VALUES FOR ICAO SCREEN 

Step Activity Anticipated Result Comment 

4 of 5 

Press <↓> to KRDR 
GRND FORKS AFB ND . 

ICAO for Grand Forks AFB ND 
is highlighted. 

Notice that Grand Forks is not 
spelled as might be expected.  
Because you do not always know 
exactly how the name was entered 
in the database, it is better to search 
on a character string you are 
relatively certain will be there, such 
as “forks” in this case.  You can try 
another combination if information 
is not found. 

5 of 5 
Click  on the OK button or 
Press  <Enter>. 

Valid ICAO Codes screen closes 
and KRDR is posted in the 
ICAO field. 

 

 

I.  Clearing a Field/Record/Form.  At times when you try to advance to the next field or block, the 
system may beep and not advance as desired with the Message Line stating “Field must be entered.”  
Even if you have cleared the field with spaces, backspaces, delete, etc., there may be an unseen 
character remaining.  Try the Clear Record icon, then if that does not work try the Clear Form icon 
to solve the problem and allow you to advance.  In some cases, Shift <Tab> will allow you to back 
out of field.  If that does not work, Exit may be your only option. 

Note.  A space is considered a character.  If you have used the space bar to replace data, it is not cleared. 

 

PRACTICE NAVIGATION - CLEAR A FIELD 

Step Activity Anticipated Result Comment 

1 of 8 
Click on the Addresses  tab 
or Addressees  navigation 
button. 

Cursor moves to the PLAD field.  

2 of 8 Click on the List icon. Valid values for PLAD screen 
displays. 

 

3 of 8 Click in the Find field. Cursor displays in the Find field.  

4 of 8 Type “%forks”. % forks displays in the Find 
field. 

 

5 of 8 Click on the Find button. Valid values for PLAD screen 
displays with matches. 

 

6 of 8 

Click on the Cancel button. Valid values for PLAD screen 
closes. 

Normally you would post what you 
looked up but we are forcing an 
error here to show you how to get 
out of it. 
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PRACTICE NAVIGATION - CLEARING A FIELD 

Step Activity Anticipated Result Comment 

7 of 8 
Click on the Remarks tab 
or navigation button. 

Screen does not change and 
Message Line displays, “Field 
must be entered.” 

There is an unseen link to the 
database that you must clear before 
you can proceed. 

8 of 8 Click  on the Clear Record 
icon. 

Clears the item (field).  Message 
Line changes. 

You may also Press <Shift + F4>. 

 

Transition.  Now you have seen the function of the List option and should use this capability whenever it 
is available in JALIS.  Next, you will successfully navigate to the Remarks Block. 

 

PRACTICE NAVIGATION - REMARKS BLOCK 

Step Activity Anticipated Result Comment 

1 of 1 
Click  on the Remarks tab 
or navigation button. 

Remarks and Remark Text 
blocks (Fig. 2-23) display. 

You may also Press <Ctrl + Pg Dn> 
or Click on the Next Block icon 
until you get there. 
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Figure 2-23.  Remarks and Remark Text Blocks 

J.  Notepad.  You have already seen how you can select items from a list in JALIS, but some of the 
fields are free-type fields, meaning there is no matching database information.  You have two 
options when entering information in these fields.  You can type it directly into the field provided on 
the screen or you can launch a Notepad window using the Edit icon or the Edit option from the Edit 
menu.  However, the text editor now used in JALIS nullifies the advantages of using Notepad.   

Objective Summary.  This part of the lesson was designed to increase your comfort level with the 
software and to show you some of the quirks in the system. 

Transition.  Now that you have practiced general navigation around the JALIS system, you will learn how 
to bookmark a request for easy retrieval. 

OBJECTIVE 2 -3.  Given instruction, bookmark a request. 

K.  Bookmarks.  Bookmarks can be set to easily retrieve requests or missions.  The Bookmarks 
menu can be accessed by right-clicking in any of several fields on the Input Airlift Request screen.  
Bookmarks work on both the large and the small screen.  There are three separate operations 
involved with bookmarks:  adding, deleting, and loading them. 

1.  Adding Bookmarks.  You add a bookmark from the Add bookmark menu option on the 
right click sub-menu.  You may have up to ten bookmarks. 

2.  Deleting Bookmarks.  You delete a bookmark from the Edit bookmark menu option on 
the right click sub-menu.  Mark the ones you want to get rid of and click on the Remove 
button. 
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3.  Loading Bookmarks.  Bookmarks added in an earlier JALIS session do not load 
automatically.  You load them from the Load Bookmarks menu option on the right click sub-
menu. 

Requirement.  Add a bookmark for the currently displayed request. 

 

PRACTICE NAVIGATION - BOOKMARK A REQUEST 

Step Activity Anticipated Result Comment 

1 of 7 

Click in the DTG(Z) field. 

If you are using the small 
Input Airlift Request screen, 
go to Step 2. 

If you are using the large 
Input Airlift Request screen, 
go to Step 4. 

Cursor moves to the DTG(Z) 
field. 

 

2 of 7 
Click  on the Requests 
navigation button. 

Message window, “Do you want 
to save the changes you have 
made?” displays. 

You may also Press <Ctrl + Pg Up> 
or Click on the Previous Block icon 
until you get there. 

3 of 7 Click  on No. Input Airlift Request screen, 
(Fig. 2-17) redisplays. 

 

4 of 7 

Right Click in the DTG(Z) 
field. 

Right Click menu (Fig. 2-24) 
displays. 

Available options on this menu will 
vary depending on your 
permissions, location in JALIS, and 
status of your bookmarks. 
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Figure 2-24.  Right Click Menu 

 

PRACTICE NAVIGATION - BOOKMARK A REQUEST 

Step Activity Anticipated Result Comment 

5 of 7 Click on Bookmarks. Bookmarks cascading menu 
(Fig. 2-25) displays. 

Available options will vary. 
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Figure 2-25.  Bookmarks Cascading Menu 

 

PRACTICE NAVIGATION - BOOKMARK A REQUEST 

Step Activity Anticipated Result Comment 

6 of 7 Click on Add to 
bookmark . 

Bookmarks cascading menu 
closes. 

 

7 of 7 

Right Click in the DTG(Z) 
field. 

Right Click menu (Fig. 2-24) 
redisplays with DTG, Lift, and 
UIC of bookmarked request at 
the bottom of the menu. 

Your request is now bookmarked.  
You can retrieve this request later 
by right-clicking in any of several 
fields on the Input Airlift Request 
screen and selecting the desired 
bookmark.  The bookmarked request 
will display on the screen.  If you 
have any unsaved work on the 
current request, JALIS will ask if 
you wish to save your work. 
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Objective Summary.  The bookmark feature allows you to quickly retrieve a request from the Input Airlift 
Request screen from either the Input or the Query mode. 

Transition.  You now know how to bookmark a request for easy retrieval.  You will learn how to use the 
bookmark to retrieve the request later.  Next you will practice executing a query by using something other 
than DTG. 

OBJECTIVE 2 -4.  Given instruction, query a request in JALIS. 

Requirement.  Query all the requests in JALIS with a lift code of F. 

 

PRACTICE NAVIGATION - EXECUTE A QUERY 

Step Activity Anticipated Result Comment 

1 of 8 
Click  on the Query icon. Message window, “Do you want 

to save the changes you have 
made?” displays. 

You may also Press <F7>. 

2 of 8 
Click  on No. Input Airlift Request screen (Fig. 

2-17 redisplays in the query 
mode. 

 

3 of 8 Press  <Tab>. Cursor moves to the Lift field.  

4 of 8 In the Lift field, Type  “f”.  
Press  <Tab>. 

F displays in the Lift field.  
Cursor moves to the UIC field. 

 

5 of 8 Click  on the Query menu 
option. 

Query pull-down menu displays. This step and the next one are 
optional. 

6 of 8 

Click on the Count Hits  
menu option. 

Input Airlift Request screen (Fig. 
2-26) displays.  Message Line 
displays “Query will retrieve X 
records.” 
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Figure 2-26.  Input Airlift Request Screen with Count Hits Message 

 

PRACTICE NAVIGATION - EXECUTE A QUERY 

Step Activity Anticipated Result Comment 

7 of 8 Click  on the Query icon. Input Airlift Request screen 
displays with query results. 

You may also Press <F8>. 

8 of 8 Press  <↓> to a request with 
a status of Scheduled. 

Moves through all records 
returned by the query. 

You may also Click on the Next 
Record icon. 

 

Note.  The status field will show Scheduled. 

Transition.  Now that you have found a scheduled request, you have the capability to see the details and 
messages associated with the mission on which the request will be flown.  You have two options in how to 
access this information from the large Input Airlift Request screen.  One of the options is also available 
from the small Input Airlift Request screen. 

L.  Request Statuses Tab.  On the large Input Airlift Request screen, you can click on the Request 
Statuses tab.  This block will display all the lifts with the same DTG and UIC as the open request.  It 
displays the status of each lift and the mission number if the request has been assigned to a mission. 
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PRACTICE NAVIGATION - REQUEST STATUSES 

Step Activity Anticipated Result Comment 

1 of 3 Click on the Request 
Statuses  tab. 

Request Statuses block (Fig. 2-
27) displays. 

 

 

 

Figure 2-27.  Request Statuses Block 

 

PRACTICE NAVIGATION - REQUEST STATUSES 

Step Activity Anticipated Result Comment 

2 of 3 
Press  <↓> to the reques t lift 
marked with an *, indicating 
the current request lift. 

Line for request lift F highlights 
and mission number displays. 

 

3 of 3 Double Click on the 
mission number. 

Display Flight Advisory screen 
(Fig. 2-28) displays. 

This screen and its tabs provide the 
details of the mission. 
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Figure 2-28.  Display Flight Advisory Screen 

M.  Navigate Pull-down Menu.  The Navigate pull-down menu (usually located in the upper right 
hand corner of the screen) provides direct navigation to other modules in JALIS.  It is the best 
method of accessing other modules from the small Input Airlift Request screen and it can also be 
used from the large Input Airlift Request screen. 

 

PRACTICE NAVIGATION - NAVIGATE WINDOW 

Step Activity Anticipated Result Comment 

1 of 3 Click on the Exit icon. Input Airlift Request screen (Fig. 
2-19) redisplays. 

 

2 of 3 
Click  on the Navigate  down 
arrow. 

Input Airlift Request - Navigate 
pull-down menu (Fig. 2-29) 
displays. 
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Figure 2-29.  Input Airlift Request - Navigate Pull-down Menu 

 

PRACTICE NAVIGATION - NAVIGATE WINDOW 

Step Activity Anticipated Result Comment 

3 of 3 Click  on Airlift Request 
Status. 

Airlift Request Status screen 
(Fig. 2-30) displays. 
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Figure 2-30.  Airlift Request Status Screen 

 

PRACTICE NAVIGATION - ACTIVATE SPECIAL NAVIGATION BUTTONS 

Step Activity Anticipated Result Comment 

1 of 1 Click  on the Display FADV 
button. 

Small Display Flight Advisory 
screen (Fig. 2-31) displays. 
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Slide 2-5.  Display Flight Advisory Screens 

 

 

Figure 2-31.  Small Display Flight Advisory Screen 
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PRACTICE NAVIGATION -NAVIGATE WINDOW 

Step Activity Anticipated Result Comment 

1 of 1 
Click  on the Navigate  down 
arrow. 

Display Flight Advisory - 
Navigate pull-down menu (Fig. 
2-32) displays. 

 

Note.  Notice the selection of available Navigate options has changed.  These vary for each screen. 

 

 

Figure 2-32.  Display Flight Advisory - Navigate Pull-down Menu 



31 March 2003 Lesson 2 JALIS 
 Introduction to JALIS 

2-52 

 

PRACTICE NAVIGATION - ACTIVATE SPECIAL NAVIGATE SCREENS 

Step Activity Anticipated Result Comment 

1 of 3 

Click  on View Message 
Text. 

 The first time you select View 
Message Text you actually go to the 
Messages block of the Display 
Flight Advisory module.  You have 
to select View Message Text again 
via the Navigate window. 

2 of 3 
Click  on the Navigate  down 
arrow. 

Display Flight Advisory - 
Navigate pull-down menu 
redisplays. 

 

3 of 3 Click  on View Message 
Text. 

Display Message Output screen 
(Fig. 2-33) displays. 

 

 

 

Figure 2-33.  Display Message Output Screen 
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PRACTICE NAVIGATION - EXIT NAVIGATE SCREENS 

Step Activity Anticipated Result Comment 

1 of 1 
Click  on the Exit icon.   
(3 times) 

Exits the screens in reverse 
sequence and returns to the Input 
Airlift screen (Fig. 2-17). 

You may also Press <Ctrl + q> (3 
times). 

 

Transition.  Earlier in this lesson you set a bookmark for a request.  Now you will retrieve that request by 
using the bookmark. 

 

PRACTICE NAVIGATION - USE A BOOKMARK 

Step Acti vity Anticipated Result Comment 

1 of 2 
Right Click in the DTG 
field. 

Right click menu (Fig. 2-34) 
displays with bookmarked 
request. 

You can right click in most of the 
fields on this screen to get to the 
menu. 

 

 

Figure 2-34.  Right Click Menu with Bookmarked Request 
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PRACTICE NAVIGATION - USE A BOOKMARK 

Step Activity Anticipated Result Comment 

2 of 2 
Click on the DTG, Lift, and 
UIC of the bookmarked 
request. 

Bookmarked request is retrieved. You can retrieve a request using a 
bookmark in either the query or the 
input mode. 

 

Objective Summary.  You can query a request on any data element that JALIS will allow you to click into 
the field.  If you want to retrieve only one request, you must query on the DTG, Lift, and UIC.  Querying 
on anything else will include your request, possibly along with several others. 

Transition.  It is just that easy to retrieve a request that you have previously bookmarked.  Now you will 
exit back to the JALIS Welcome screen. 

 

PRACTICE NAVIGATION - RETURN TO WELCOME SCREEN 

Step Activity Anticipated Result Comment 

1 of 1 
Click  on the Exit icon. Joint Air Logistics Information 

System Welcome screen (Fig. 2-
4) redisplays. 

You may also Press <Ctrl + q>. 

 

Transition.  Now that you have had an opportunity to practice general navigation in JALIS and executing a 
query, you can perform the function of printing the Flight Advisory (FADV).  All reports in JALIS print 
basically the same way.  The only real differences are how you get to the report, the parameters you set on 
the preferences page, and the output you get. 

OBJECTIVE 2 -5.  Given instruction, print a Flight Advisory Message. 

N.  Reports.  JALIS provides a number of canned reports.  These reports cover a variety of topics in 
JALIS and are preformatted.  They all start with a pre ferences screen where many of them provide 
some options to allow you to filter the records you retrieve on your report.  Some of them do not.  
You can view the reports on screen, print them directly, or do both with the Preview option.  The 
Flight Advisory Message is the official mission tasking mechanism within JALIS and is one of the 
available reports.  Others will be covered as they arise during the course.  

Requirement.  Print the Flight Advisory Message for the mission WAB197792. 
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NAVIGATE TO MESSAGES  REPORT 

Step Activity Anticipated Result Comment 

1 of 3 
Click  on the JALIS  menu 
option. 

Menu options for specific users 
(Fig. 2-5 through Fig. 2-7) 
redisplay. 

You may also Press <Alt + J>.  

2 of 3 

Click  on the Messaging 
Menu option. 

Squadron Users Click  on 
the Remote  Squadron User 
Menu option. 

Messaging Menu cascading 
menu (Fig. 2-35) displays. 

Remote Squadron User 
cascading menu displays. 

You may also Press <M>. 

You may also Press <Q>. 

 

 

Figure 2-35.  Messaging Menu Cascading Menu 
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NAVIGATE TO MESSAGES REPORT 

Step Activity Anticipated Result Comment 

3 of 3 Click  on Messages Report. Messages Report screen (Fig. 2-
36) displays. 

You may also Press <M> twice and 
then Press <Enter>. 

 

 

Figure 2-36.  Messages Report Screen 
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PRINT FLIGHT ADVISORY MESSAGE 

Step Activity Anticipated Result Comment 

1 of 10 

Click  on the List icon 
adjacent to the Output To 
field. 

List of Valid Destinations pop-
up (Fig. 2-37) displays. 

Screen sends the report to the screen 
only.  File creates a text file, but this 
function does not work properly at 
this time.  Printer sends the report 
directly to the printer.  Preview is 
the default option.  It sends the 
report to screen from where you can 
also print it.  Preview is the best 
method to print a report. 

 

Note.  When the system changes to true web access, the output to options will change to PDF, HTML, and HTML 
CSS. 

 

Figure 2-37.  List of Valid Destinations Pop-up 
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PRINT FLIGHT ADVISORY MESSAGE 

Step Activity Anticipated Result Comment 

2 of 10 Click  on Preview.  Click  on 
the OK button. 

Preview is highlighted.  Preview 
displays in the Output To field. 

Should default to Preview. 

3 of 10 
Press  <Tab> (3 times) or 
Click  in the Mission 
Number field. 

Report Preferences screen 
displays with the cursor in the 
mission number field. 

 

4 of 10 Type “wab197792” and 
Press  <Tab>. 

DTG and Mission Number post.  

5 of 10 
Click  on the Run Report 
button. 

JALIS_MSG_: Previewer - 
MESSAGES REPORT screen 
(Fig. 2-38) displays. 

A header page similar to this one 
appears as the first page of all 
reports in JALIS. 

 

 

Figure 2-38.  JALIS_MSG_: Previewer - Messages Report Screen 

O.  Report Previewer.  Navigation through this report, or any JALIS report, is accomplished by use 
of the navigation buttons provided on the Report Previewer. 

1.  Print.  The Print icon will open the Print dialog box from which you can print the report. 
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2.  Page Setup.  The Page Setup icon opens the Page Setup dialog box where you can set the 
margins and orientation of the page.  This option also allows you to select your printer. 

3.  Mail.  The Mail icon should allow you to e-mail the report.  However, this function is not 
currently available. 

4.  New Previewer.   The New Previewer icon will open another screen showing the same 
report.  Opening two or more screens that contain the same report will allow you to compare 
information found in different parts of the report. 

5.  Close Previewer.  The Close Previewer icon will close the report and return you to the 
initial Messages Report screen , or the input screen from which you ran the report.  Note that 
the Close Previewer icon is a red X.  Everywhere else in JALIS the red X is the Delete 
Record icon.  The Previewer is actually a separate program. 

6.  Zoom In.  The Zoom In icon will zoom in on the report, making the text larger.  It will 
only zoom once. 

7.  Zoom Out.  The Zoom Out icon will zoom out on the report, making the text smaller.  It 
will zoom more than once. 

8.  First Page.  The First Page icon will return you to the beginning of the report . 

9.  Previous Page.  The Previous Page icon moves you to the previous page of the report.  If 
you are on the first page, this option is not available. 

10.  Next Page.  The Next Page icon will move you to the next page of the report.  If you are 
on the last page, this option is not available. 

11.  Last Page.   The Last Page icon will move you to the last page of the report. 

12.  Page Field.  The Page field displays the current page of the report.  You can go directly 
to a specific page by clicking in the field where the number is displayed, deleting the current 
page number, and typing the appropriate page number.  Once the number has been typed, 
Press <Enter> to move to the specified page of the report. 

13.  Help.  The Help icon opens the Report Builder Help window. 

 

PRINT FLIGHT ADVISORY MESSAGE 

Step Activity Anticipated Result Comment 

6 of 10 Click  on the Next Page 
icon. 

Formatted Flight Advisory 
message (Fig. 2-39) displays. 
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Figure 2-39.  Formatted Flight Advisory Message 

 

PRINTING FLIGHT ADVISORY MESSAGE 

Step Activity Anticipated Result Comment 

7 of 10 
Click  on the Print icon. Print screen displays with your 

assigned network printer 
identified. 

You can adjust the number of copies 
as well as which pages to print. 

Note.  Note:  The first and last pages of all the reports are header and trailer pages.  You can save paper by not 
printing those two pages. 

8 of 10 Click  on the OK button. Report prints.  

9 of 10 Click  on the Close 
Previewer icon. 

Messages Report (preferences) 
screen (Fig. 2-36) redisplays. 

 

10 of 10 
Click  on the Exit icon. Joint Air Logistics Information 

System Welcome screen (Fig. 2-
4) redisplays. 
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Objective Summary.  This is only one of many reports available in JALIS.  All the reports work very 
much the same way. 

Transition.  Now that you know how to print a Flight Advisory Message you can carry it to the fax 
machine and send it to whoever needs it.  However, in many cases it might be easier to just send someone 
the Flight Advisory Message by e-mail.  You can do this right from JALIS.  With this JALIS function, 
users have the capability to print or e-mail the Flight Advisory Message from their own e-mail systems. 

OBJECTIVE 2 -6.  Given instruction, e-mail a Flight Advisory Message. 

P.  E-mail a Flight Advisory Message.  JALIS provides the capability to e-mail some messages 
from within JALIS.  You can e-mail the FADV to your customers or whoever needs to be kept 
apprised of someone’s travel.  As a fallback position if you are having trouble printing within 
JALIS, you can e-mail the FADV to yourself, and then print it from your e-mail program.  

Requirement.  E-mail the Flight Advisory Message for mission WAB197792 to yourself. 

 

NAVIGATE TO E-MAIL  

Step Activity Anticipated Result Comment 

1 of 7 
Click  on the JALIS  menu 
option. 

Menu options for specific users 
(Fig. 2-5 through Fig. 2-7) 
redisplay. 

You may also Press <Alt + J>.  

2 of 7 

Click  on the Messaging 
Menu option. 

Squadron Users Click  on 
the Remote Squadron User 
Menu option. 

Messaging cascading menu (Fig. 
2-35) redisplays. 

Remote Squadron User 
cascading menu redisplays. 

You may also Press <M>. 

 
You may also Press <Q>. 

3 of 7 Click  on E-Mail Messages . E-Mail Messages screen (Fig. 2-
40) displays. 

You may also Press <E>. 
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Figure 2-40.  E-Mail Messages Screen 

 

NAVIGATE TO E-MAIL 

Step Activity Anticipated Result Comment 

4 of 7 
In the first Mission field, 
Type “wab197792”.  Press 
<Tab>. 

WAB197792 displays in the first 
Mission field.  Cursor moves to 
the first Email Address field. 

 

5 of 7 
In the first Email Address 
field, Type {your e-mail 
address}. 

E-mail address displays in the 
first Email Address field. 

You can list multiple E-mail 
addresses by separating them with a 
comma. 

6 of 7 

Click  on the Send button. A forms pop-up displays with 
the message, “Processing 
Completed.  E-mail has been 
sent.” 
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NAVIGATE TO E-MAIL 

Step Activity Anticipated Result Comment 

7 of 7 
Click  on the OK button. The pop-up message disappears.  

E-Mail Messages screen (Fig. 2-
40) redisplays. 

You may also Press the <Enter> 
key. 

Note.  If you Double Click on the status for the message that posts after it has been sent, JALIS will display the 
message in a Notepad window. 

Note.  You may send several messages at once.  Type the mission number for each FADV you wish to send and an 
E-mail address for each.  You can enter multiple E-mail addresses by separating the addresses with a comma. 

 

Transition.  With your newfound knowledge of JALIS, it is time to properly exit the program. 

Q.  Exit JALIS.  Exiting JALIS by the proper method creates a graceful exit and eliminates many 
problems that are caused both system-wide and individually by people improperly exiting JALIS.  
There are two acceptable methods of exiting JALIS gracefully.  One is to click on the Exit icon (Red 
Door).  The other is to select Exit JALIS from the File menu.  The major unacceptable method is to 
click on the large X at the top right corner of the window.  That works well for exiting most 
Windows programs but remember, JALIS is NOT a true Windows program. 

Note.  If you have run a report using the Report Previewer at any time during the current session of JALIS, the 
program will stop part way through the exit routine.  It stops with a black screen and a minimized Reports 
Background Engine window in the lower left corner of the window.  Click once on the X at the top of the icon and 
JALIS will then continue to exit gracefully.  You can click the X here, but not on the JALIS window, because the 
Reports Background Engine is a true Windows program. 

 

EXIT JALIS  

Step Activity Anticipated Result Comment 

1 of 3 
Click  on the Exit icon. Joint Air Logistics Information 

System Welcome screen (Fig. 2-
4) redisplays. 

You may also Press <Ctrl + q>. 

2 of 3 

Click  on the Exit icon. Black screen displays with the 
Reports Background Engine 
window in the lower left corner. 

The exit process only stops here if 
you have run a report during the 
current session in JALIS.  
Otherwise, the Exit command will 
take you straight to the desktop. 
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EXIT JALIS  

Step Activity Anticipated Result Comment 

3 of 3 

Click  on the X on the 
minimized Reports 
Background Engine 
window. 

Windows Desktop (Fig. 2-1) 
redisplays. 

 

Note.  You may exit JALIS by using the Exit icon or the Exit JALIS option on the File menu.  You must NEVER 
exit JALIS by clicking on the X at the top right corner of the window.  That does not exit JALIS completely.  It  will 
terminate your connection to the JALIS server, but it leaves your session on the JALIS database running.  This tends 
to slow the system for all users and may limit your ability to print if you try later in the day. 

 

Transition.  You have seen how JALIS currently functions.  As JALIS evolves, there will be future 
enhancements to make your job easier. 

R.  Enhancements.  Even though JALIS was converted from its original Character User Interface 
(CUI) to a Graphical User Interface (GUI) to a web-enabled system, it is still considered a mature 
system.  Some of the other enhancements include: 

1.  Web Access.  JALIS is currently accessible through the Citrix WinFrame Client-Server 
software.  At some point down the road you will be able to access JALIS through your web 
browser. 

2.  Global Transportation Network (GTN) Interface.  To provide more information in the 
in-transit visibility area, JALIS has been interfaced with the current version of GTN.  JOSAC- 
tasked OSA missions are now visible using GTN. 

3.  Single Mobility System (SMS) Interface.  The CONUS OSA flying schedule is available 
to users with an SMS account.  This portal is an effort to make all movement information 
available to users in a single location.  Like GTN, SMS is accessed through the internet and 
requires a separate userid and password. 

4.  World Wide Web (WWW) Interface.  JOSAC’s mission schedule is available via the 
World Wide Web for review on the JALIS home page.  It is important for you to know how 
to access the JALIS home page to find help on JALIS, updates to the training manual, and to 
keep abreast of the scheduled missions. 

Objective Summary.  E-mailing a Flight Advisory Message is a handy way to inform your customers of 
the itinerary of their flights.  It is also a good backup if you have printer problems in JALIS. 

OBJECTIVE 2 -7.  Given instruction, become familiar with the contents of the JALIS home page. 

Requirement.  Navigate to the JALIS home page and become familiar with its contents. 
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NAVIGATE TO THE JALIS HOME PAGE 

Step Activity Anticipated Result Comment 

1 of 10 

Double Click  on the 
Internet Explorer icon on 
the desktop.  

Internet Explorer opens. You may also use Netscape 
Communicator or any other web 
browser, although some functions 
are designed to work best with 
Internet Explorer. 

2 of 10 

In the Address box, Type 
“https://josac.transcom. 
mil” and Press  <Enter>. 

JOSAC Home Page - Microsoft 
Internet Explorer (Fig. 2-40) 
displays. 

Links on this page allow you to 
apply for an account, submit a 
change request, download software, 
view a searchable OSA schedule, 
and find help about JALIS 
functions, among other things. 
 

Note.  Note.  You may get a pop-up page with current information for JALIS users. 

 

 

 

Figure 2-41.  JOSAC Home Page - Microsoft Internet Explorer 
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NAVIGATE TO THE JALIS HOME PAGE 

Step Activity Anticipated Result Comment 

3 of 10 Click on the gui jalis  tab. Introduction to JALIS page 
displays. 

 

4 of 10 
Click on the connecting to 
jalis  link on the right. 

Connecting to the GUI 
JALIS/JOSAC Server page 
displays. 

This page contains the instructions 
and the files to download to install 
JALIS. 

5 of 10 

Click on the training tab. JALIS Training page displays. From the links on the right you can 
download the JOSAC User’s Guide, 
the DoD regulations governing 
OSA, and the JALIS Training 
Manuals, as well as find the JTO’s 
class schedule. 

6 of 10 

Click on the training 
references  link on the right. 

DOD Regulations and JALIS 
Training Manuals and 
Documentation page displays. 

This page contains the DoD and 
JOSAC guidance for the OSA 
system and the JTO JALIS Training 
Manuals. 

7 of 10 

Click  on the flt schedules  
tab. 

Flight Schedules page displays 
with three options. 

The public searchable schedule and 
the comprehensive schedule will 
give you almost real time 
information from the JALIS 
database.  You can search the JALIS 
database for missions flying on 
certain days and originating, 
transiting, or arriving at specified 
locations. 

 

Note.  If your server is not a registered DoD or Military (.gov or .mil) server, you cannot access any of the flight 
schedules. 

8 of 10 Click  on the help tab. Help Information page displays.  

9 of 10 
Click on the jalis help link 
on the right. 

JALIS Mini Lesson page 
displays. 

Provides step by step instructions 
for accomplishing several tasks in 
JALIS. 

10 of 10 
Click on the links tab. Links to other OSA agencies are 

provided. 
Navy users need to go to the NALO 
page to apply for their NALO 
accounts. 

 

Transition.  Navy users who are NOT assigned to a joint command must also apply for a JALIS account 
on the NALO system.  The next set of keystrokes will get you to the account application form that Navy 
users must complete and fax to NALO. 
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GET APPLICATION FORM FOR NALO ACCOUNT 

Step Activity Anticipated Result Comment 

1 of 3 Click on the NALO link. Navy Air Logistics Office home 
page displays. 

 

2 of 3 Click on the File Library 
link on the left. 

List of files displays.  

3 of 3 
Click on the link for NALO 
5280.1E GUI User Access 
Request. 

Form 5280.1E opens in your 
word processing program. 

You may complete the form and 
print it, then fax it to NALO. 

 

Transition.  You saw one place to get the DD Form 2768 on the JALIS home page.  There are other 
electronic formats of this form available.  The DD Form 2768 is to be used by all DoD individuals 
requesting OSA support for passengers and cargo.  Validators are required to maintain the forms for two 
years.  Follow the keystroke table below to obtain the proper form. 

 

NAVIGATE TO DD FORM 2768 

Step Activity Anticipated Result Comment 

1 of 11 Double Click  on the 
Internet Explorer icon. 

Internet Explorer opens. You may have a different program 
for connecting to the Internet. 

2 of 11 

Click  on the Address box.  
Type 
http://web1.whs.osd.mil.  
Press  <Enter>. 

Department of Defense - 
Washington Headquarters 
Services web page displays. 

 

3 of 11 Click on the Forms & 
Reports  button. 

DoD Forms and Reports page 
opens. 

You may also click on the links on 
the left side of the page. 

4 of 11 Click on the DoD Forms 
Program button. 

DoD Forms Program page 
opens. 

You may also click on the links on 
the left side of the page. 

5 of 11 Click on Forms  
Inventories . 

DoD Available Electronic Forms 
page opens. 

 

6 of 11 
Click on Department of 
Defense Forms . 

Listing of Department of 
Defense (DD) Forms page 
opens. 

 

7 of 11 

Click on DD2500 through 
DD2999. 

Department of Defense 
Electronic Forms By Form 
Number DD2500 through 
DD2999 opens. 
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NAVIGATE TO DD FORM 2768 

Step Activity Anticipated Result Comment 

8 of 11 
<↓> to DD2768. Advances to the Military Air 

Passenger/Cargo Request form 
with options. 

You may also use your browser’s 
find function to quickly find 2768. 

Note.  Notice that there are three separate electronic versions of the form available.  Use one of the first two if you 
have an electronic forms program on your computer.  Copy the file to the folder on your computer where the 
program stores the templates.  If you do not have an electronic forms program, you may still fill out the Fillable 
Adobe PDF format online if you have downloaded the free Adobe Acrobat reader program. 

9 of 11 

Click on the Fillable Adobe 
PDF option. 

DD Form 2768 opens in Adobe 
Acrobat Reader. 

You may complete the form online 
and print it.  You may save the form 
itself but not any of the information 
you type in it. 

10 of 11 Click on the File menu 
option. 

File pull-down menu displays.  

11 of 11 
Click on Close. Closes the form and returns you 

to your last web page. 
If more Internet work is to be done, 
use the Back button to return to 
previous pages. 

 

Objective Summary.  The JALIS home page contains a wealth of information that can help you do your 
job, including flying schedules and JALIS help. 

Transition.  Now that you know where to find the JALIS home page and what information is available 
there to help you, as well as several versions of the DD Form 2768, you can now exit your browser. 

 

EXIT NETSCAPE 

Step Activity Anticipated Result Comment 

1 of 2 

Click  on the File menu. File pull-down menu displays. You may click on the X at the top 
right corner of the screen since this 
is a true Windows program, not 
JALIS. 

2 of 2 Click  on Exit. Internet Explorer closes.  
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Slide 2-6.  We have covered… 

Lesson Summary.  This lesson has covered a significant area of your introduction to the JALIS 
environment and general navigation in JALIS.  This is the foundation for the remaining lessons. 

Remotivation.  This lesson provided the procedures you will need to navigate through the system and 
make JALIS work for you instead of you working for JALIS. 

Closure.  You are not expected to be an expert from this lesson but the requirements and scenarios that are 
planned for you will certainly help. 
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